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Nodeskrivning med Sibelius 7.5 

1. De indledende øvelser 

Materiale: En eksempelfil, f.x. Funk.sib  

1.1.  Indledning 

Sibelius er et dedikeret nodeskrivningsprogram til PC og Mac udviklet af englænderne 
Jonathan og Ben Finn. Det er skrevet på engelsk, hvilket medfører at alle musikalske 
termer (node, pause, takt, hals osv.) har engelske betegnelser (note, rest, bar, stem). 
Programmet er intuitivt opbygget og henvender sig til de brugere, som er bekendte med 
de mest grundlæggende konventioner indenfor nodenotation og primært efterspørger et 
redskab til at give deres arrangementer et professionelt layout og samtidig få de mange 
fordele der følger med den computerbaserede nodeskrift (let adgang til korrektur og 
transponering f.x. samt mulighed for at høre arrangementer afspillet). 

1.2. Genvejstaster (key commands) 

Nodeskrivning med Sibelius kan gøres udelukkende ved hjælp af musen. Men det anbefa-
les ikke. Faktisk overhovedet ikke. Sibelius har nemlig en række genvejstaster som gør 
arbejdet meget lettere. Man skal bare lære dem og huske dem. Nogle er selvindlysende 
andre ikke. I det følgende bliver alle funktioner beskrevet som klik-kommandoer men 
med genvejstasten i parentes. Nogle genveje har kun en enkelt tast, mens andre gør 
brug af en moderator-tast, nogle gange to. Så sørg for at blive fortrolig med Ctrl/⌘, 
Alt/⌥, Shift og TAB – tasterne. 

1.3.  Første indtryk 

Inden du begynder at skrive dine egne noder kan det være instruktivt at mærke hvorle-
des programmet føles at arbejde med. Dette gøres mest praktisk med en præfabrikeret 
nodefil. Når programmet åbner bliver du mødt af quick start-menuen, som har 5 fane-
blade/tabs: Learn, New score, Recent, Import og Latest News. I Learn menuen finder 
du videoer og tutorials (vejledninger), til hjælp for dit nodeskrivningsarbejde. I New 
Score finder du mere end 60 skabeloner til at påbegynde en ny node. Recent viser en 
oversigt  over seneste nodefiler. Importfanen giver mulighed for at importere fx en midi-
fil eller skanne en trykt node med Photoscore. Latest news rummer nyheder om Sibeli-
us. Man kan fravælge Quick-
start menuen ved start af Si-
belius ved at fjerne fluebenet:  

1.4. Åbning af demo score 

Klik på ”Open Other.... Dette bringer dig formentlig ud i Sibeliusmappen. Klik på map-
pen Sibelius Example Scores og prøv at vælge filen ”Funk”. (Hvis du ikke er i Sibeli-
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usmappen automatisk skal du den tunge vej gennem de forskellige mapper på harddi-
sken, afhængig af platform). Klik OK og iagttag straks det færdige comboarrangement 
med titel, komponist, accenter, buer m.m.m. 

1.5. The Ribbon 

For brugere af tidligere versioner af Sibelius er version 7.5 lidt af en ”extreme make-
over” ved første blik. Det skyldes at den velkendte menustruktur er erstattet af et bånd 
kaldet ”Ribbon”, som i langt højere grad illustrerer de hundredevis af forskellige funkti-
oner. Båndet er udstyret med 11 faner, som hver især indeholder beslægtede funktio-
ner. Det kan virke uoverskueligt men i det følgende stifter du bekendtskab med de vig-
tigste.  En meget værdifuld funktion er ”Find in Ribbon”-søgefeltet øverst i højre hjør-
ne. her kan man indtaste søgeord og Sibelius vil straks vise vej til funktionens placering. 
Når alt andet glipper............................. 

1.6. Afspilning af node (transport) 

Sjette fane i båndet hedder Play. Klik der og find transportpanelet med alle de kendte 
symboler for frem-/tilbagespoling, optag, stop etc. Klik på 
play-knappen (eller tast Mellemrum) og lyt til (MI-
DI)musikken. Bemærk den lodrette grønne ”playback 
line”, der viser vej i noden. Klik på ikonet ”stop” (eller 
tast Mellemrum) når du har hørt nok. Hvis du klikker Play 
eller taster Mellemrum spiller Sibelius videre fra hvor den 
kom til. P-tasten (for play) afspiller enten forfra, eller forfra i en given markering. Prøv 
fx at markere tromme- og bassystemet. Øvrige genvejstaster er (Windows) Frem: Å, til-
bage ´ (accent aigu), (Mac): Frem: [, tilbage: ]. Tast M (for mixer), for at justere balan-
cen mellem instrumenterne. Der er også 
et flydende Transport vindue, som ikke 
er fremme som udgangspunkt. Eftersom 
det også indeholder temposlideren er 
det en god ide at kalde det frem. Det 
findes under View > Panels > Transport 
(Ctrl-alt+Y).  

1.7.  Udseendet/følelsen: 

Som du nok har bemærket ser noden ud som om den er trykt på et stykke rigtigt papir. 
Fornemmelsen af at være tæt på den håndskrevne virkelighed træder endnu tydeligere 
frem når man tager fat i papiret med musen (venstreklik+ hold nede udenfor nodesyste-
merne) og skubber rundt med det som om det lå på et bord foran én. 

1.8.  Navigation 

Der er to måder at se sine noder på i Sibelius: Sidevisning og Panorama. I sidevisning ser 
man sit arrangement som det vil se ud i trykt form. I panorama er det i et 
langt fortløbende billede. Du finder Panorama on/off nederst i højre hjørne . 
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Alternativ kan man taste Shift+P.  For at navigere rundt i partituret kan man trække 
med musen, men man kan også bruge home (mod begyndelsen), end (mod slutningen) 
page up (opad), page down (nedad) til navigation. 

1.9.  Zoom 

Du kan zoome ind og ud v.h. af luppen (zoom tool), som findes i View-fanen. Venstreklik 
med luppen i noden og du vil få større forstørrelser – mindre med højreklik. Man kan og-
så trække et område op. Alternativt kan bruges ctrl + num +/- eller ctrl+ scrollhjul. I 
nederste højre hjørne findes en skyder som gør det samme.  

1.10. Selection – at vælge/markere 

En vigtig handling i Sibelius er den at markere det, man vil arbejde på. Grundlæggende 
er det som i andre programmer blot at klikke på det aktuelle objekt, en takt, en node, 
en stump tekst osv. Ønsker man en mere specifik markering er der forskellige måder det 
kan gøres på. Et klik et tomt sted i en takt markerer denne. Et dobbeltklik samme sted 
markerer hele systemet, og et trippel-klik markerer stemmen i hele nodens længde. 
Senere introduceres flere markerings- og udvælgelsesværktøjer. Læg for nu blot mærke 
til at det er vigtigt at holde øje med hvad man har markeret. Så vigtigt, at selve marke-
rings-handlingen også kommer ind under ”Undo”-funktionen (Ctrl + Z / ⌘ +  Z). 

1.11. Sibelius 7 Sounds 

Sibelius har et stort lydbibliotek med samplede lyde i høj kvalitet. Du kan vælge mellem 
det store Sibelius 7 Sounds, eller de mindre Sibelius 7 Sounds Chamber, Jazz eller Lite. 
Disse valg foretager du under fanen Play > Configuration. Det er som udgangspunkt en 
god ide at bruge disse lydbiblioteker, da de lyder godt og er uden forsinkelse, når du 
spiller med MIDI-keyboard. Til gengæld er der som udgangspunkt en masse rumklang på, 
hvilket kan være forstyrrende. Dette kan fjernes i Mixeren (M). Ved meget store partitu-
rer kan Sibelius dog godt tabe pusten og det kan være nødvendigt at skifte til standard 
General MIDI.  

1.12.  Genvejstaster 

Mange kommandoer udføres i Sibelius med samme genvejstaster som i Word og andre 
windows-programmer. F.X: kopier (ctrl+c), Klip (ctrl+x), sæt ind (ctrl+v), vælg alt 
(ctrl+a), fortryd (ctrl+z) m. fl.  

2. Den første node 

Forlæg: Tænk hvis jeg sad på månen 

2.1.  En ny node (New Score) 

Du skal indtaste sangen ”Tænk hvis jeg sad på månen”, som findes som pdf-forlæg. Gå 
således frem: I File-fanen vælg New eller tast Ctrl + N / ⌘ + N. (Fra Quick Start-
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menuen: vælg New score.) I den resulterende dialogboks vælg Treble Staff (nodelinje 
m. g-nøgle). Det åbner en dialog, hvor du kan foretage en række indstillinger. 

2.2. Document setup 

Her vælger du sidestørrelse og format. A4 og Portrait (højformat). 

2.3. House Style 

Her vælger man mellem forskellige foruddefinerede layouts. Ved at markere de forskel-
lige muligheder ses et eksempel i venstre side. 

2.4. Time Signature, tempo og optakt. 

Her indstilles bl.a. sangens taktart og tempo. Vælg 4/4 eller C. Et flueben i Metronome 
mark indsætter en metronomangivelse, og et flueben i Pickup bar sørger for at noden 
starter med en optaktstakt af den angivne længde: Sangen ”Tænk hvis jeg sad på må-
nen” har en fjerdedelsoptakt. Her skal du fortælle Sibelius det ved at sætte flueben i 
”Start with bar of length” og vælg en fjerdedelsnode i drop-down-menuen. 

2.5. Key Signature 

Her vælges tonearten. Mulighederne er opdelt i dur og mol. Sangen her går i C dur. 

2.6. Score Information Setup 

Her indsættes alle de vigtige oplysninger titel, komponist, tekstforfatter og copyrightin-
dehaver. Og så klikker man på Create. Nu skulle man gerne se en nodeside for sig med 
de indtastede oplysninger, men endnu ingen noder. Brug dette øjeblik til at gemme no-
den. Brug funktionen Save as (Ctrl+ shift+ S) og giv noden en titel hvori dit eget navn 
indgår. Huske at gemme på dit P-drev, hvor du har adgang til den fra en hvilken som 
helst computer på DJM. 

2.7.  Senere ændringer 

Alt hvad man indstillede i løbet af de netop gennemgåede dialo-
ger kan ændres efterfølgende, hvis man får lyst. Hvis man højre-
klikker i noden fremkommer en menu hvor man kan ændre in-
strument-besætning (I), takt- (T) og toneart (K), diverse tekstty-
per m.m.m. og her er de relevante tastegenveje også at se. Skul-
le man have glemt en optakt laves den ved at vælge Time Signa-
ture (T) (taktartsangivelse), og derefter More Options. Al tekst 
(næsten, i hvert fald!) kan desuden rettes ved at dobbeltklikke 
på den; herved kan den redigeres som i ethvert tekstbehand-
lingsprogram. 

2.8. Keypad (numerisk tastatur) 

På skærmen ses Keypad’et, et flydende vindue hvis udseende og funktion modsvarer 
computerens numeriske blok til højre på tastaturet. Man kan klikke på knapperne i dette 
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vindue såvel som bruge tasterne på det numeriske tastatur. Man kan 
skjule/vise dette vindue under fanen View > Panels; tastegenvejen 
Ctrl + Alt + K / ⌘ + ⌥ + K er dog hurtigst. Der er 6 forskellige lay-
outs på Keypad’et. Man skifter mellem dem med knapperne øverst i 
vinduet, vha. tasterne F7 – F12 eller med +-tasten på NUM-pad’en. 
Som det fremgår, er der adskillige funktioner gemt i dette vin-
due/tastatur. 

Vælg nodeværdien ¼-del(klik på den eller tast 4 på nummertastatu-
ret). Hermed bliver musemarkøren blå og hælder mod venstre. Det 
er Sibelius’ måde grafisk at vise at musen er ”ladt”, dvs. at der 
hvor man nu klikker med musen vil der blive indsat en fjerdedelsnode. Hold musen over 
en nodelinje og observér den grå ”spøgelsesnode” som viser hvilken tonehøjde der bliver 
indsat ved klik. Prøv at indsætte nogle noder på en linje. En indsat (og markeret) node 
kan flyttes op og ned med piletasterne. For at gå ud af ”input-mode”: tast Esc. 

2.9. Muse - input 

Kig over på den trykte node ”Tænk hvis jeg sad på månen”. Indsæt et par takter af me-
lodien vha. musen. Skulle du nå til halvnoden skal du blot klikke på symbolet i keypad-
vinduet eller taste 5 på nummer tastaturet, hvorefter du fortsætter. 

2.10. Taste-input (alfabetisk input) 

Man kan også indsætte noder vha. bogstav-tasterne A – G på computerens tastatur; de 
indsætter den tilsvarende diatoniske tonehøjde, igen med den nodeværdi man har for-
valgt på det numeriske tastatur. Læg mærke til at tonen H skal indsættes vha. B, da 
programmet er engelsk-sproget. Løse fortegn forvælges også på det numeriske tastatur, 
eller indsættes efterfølgende. Hver ny tonehøjde indsættes i den oktav nærmest på fo-
regående node. Umiddelbart efter indsætning kan tonen oktaveres med tastegenvejen 
Ctrl + pil op/ned / ⌘ + pil op/ned. Indtast yderligere et par takter 
af melodien: Klik et tomt sted i den takt, hvor du skal indsætte no-
der. Den skal blive markeret som på billedet (enkelt lyseblå ramme).  

Herefter vælger du nodeværdien og indsætter tonehøjden m. ta-
sterne. Skal du starte midt i en takt, marker da pausen (klik på den) 
der hvor du skal indsætte næste node. I dette tilfælde er en halv-
nodepause valgt; derfor er nodeværdien allerede sat til en halvno-
de.  Vælger man nu som det første en fjerdedel (tast 4 på num. 
tast) ændres pausen til to fjerdedelspauser.   

2.11. Step-time-input (m. MIDI- keyboard) 

Er man så heldig at have et MIDI-keyboard tilsluttet computeren er dette en fordelagtig 
måde at indsætte noder, ikke mindst fordi klange kan indsættes direkte, og ikke-
diatoniske toner giver sig selv. Som med de andre metoder forvælges nodeværdien på 
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det numeriske tastatur, hvorefter man ”spiller” noderne ind. Indsæt resten af melodien 
på denne måde.  

2.12. Sangtekst 

Så er tiden kommet til at indsætte sangteksten. Marker den første tone der skal være 
tekst under. Vælg fanen Text > Lyrics > Lyrics line 1 (Ctrl + L / ⌘ + L). Herved frem-
kommer en markør nedenunder tonen. Indtast første ord (”Tænk”) og tast mellemrums-
tast, hvorved indtastningsfeltet hopper til næste tone. Ved flerstavelsesord benyttes 
bindestreg til at gå til næste tone og samtidig ind-
sætte bindestregen. Ved stavelser trukket ud over 
flere toner tastes mellemrum eller bindestreg til 
man kommer til næste stavelses tone. Taster man 
fejl, kan man gå baglæns med piletasten. 

2.13. Becifringer 

Becifringssymboler indsættes på tilsvarende måde. Marker den første tone der skal være 
en becifring over, og vælg fanen Text > Chord Symbol (Ctrl + K / ⌘ + K). I det frem-
komne felt kan becifringen indtastes som sædvanligt; Sibelius fortolker det indtastede 
og kreérer et becifringssymbol efter bestemte retningslinjer (disse kan reguleres i dialo-
gen Appearance > Engraving Rules > Chord Symbols…). F.x. kan symbolet ”Gm7” indta-
stes som både gm7, Gm7, Gmi7 og Gminor7. Når becifringen er indtastet kommer man 
videre til den næste vha. mellemrumstasten. Den hopper fra node til node, men stopper 
også på alle pulsslag, f.x. for hver fjerdedel i 4/4. Også her kan man bruge piletasten til 
at gå baglæns og rette fejl. 

TIP! Hvis man har et keyboard tilsluttet kan man blot spille den akkord der skal indsæt-
tes. Sibelius foretager en hurtig analyse af den klang du spiller og viser becifringen. 

Sibelius kan transponere becifringer (mere om dette senere), men kun hvis de er skrevet 
med store bogstaver! Derfor er det i udgangspunkter ikke muligt at skrive bastoner (i 
”slash-akkorder”, f.x. G/D) med små bogstaver. 

2.14. Enkelt layout 

Nu har vi indsat alle elementer på leadsheetet, og kan læne os tilbage og beundre det 
foreløbige værk. Sandsynligvis er der dog et par ting der skal rettes til, før det sendes i 
trykken. Der er sikkert lovlig mange takter i overskud til sidst i noden. De fjernes sådan: 
klik i den første takt der skal slettes, Shift-klik i den sidste takt. Nu skulle de gerne være 
markeret med den lyseblå ramme. Vælg fanen Home > Bars og klik Delete (eller tast Ctrl 
+ Delete / ⌘ + Delete). Skulle man ønske at flytte lidt på tekst eller nodesystemer ind-
byrdes, er det blot at klikke og trække. For nodesystemers vedkommende er det bedst 
at klikke et tomt sted i en takt og så trække. De øverste tekststumper (tit-
len, komponisten osv.) er defineret i forhold til nodens første takt, så de føl-
ger med nedad. Dem kan man så efter behov flytte lidt opad igen til de står 
rigtigt. Hvis al musikken stadig står på én linje kan man dele denne linje i to 
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sådan: Markér taktstregen efter fjerde takt som på billedet (den skal blive violet) og tast 
Return.  Dette indsætter et linjeskift, som man kan ophæve igen på samme måde.  

Tekstens punktstørrelse og skrifttype m.m. kan redigeres i menupunktet ”Edit Text Sty-
les” (Ctrl+alt+shift+t), som findes i fanen ”Text” > Styles (klik på den udadgående pil). 
Her redigeres definitionerne på alle teksttyper. Hvis du ikke ved hvad en bestemt tekst-
type hedder, kan du markere den og kigge i Properties-vinduet, i feltet ”Text”. 

3. Den næste node 

Forlæg: Elefantens Vuggevise  
Hjælpefil: Elefantens vuggevise.txt 
 

3.1. En ny node 

Klik atter på fanen File > New eller tast Ctrl + N. Gå gennem Quick Start-menuen igen, i 
det du iagttager forlægsnoden ”Elefantens Vuggevise”. Husk at vælge en optakt på en 
ottendedel. Den House Style som er brugt til forlægget er ”Lead Sheet Inkpen2”. Indsæt 
melodien med din foretrukne input-metode! Pauser indsættes også vha. Keypad’et. Skal 
du bruge en ottendedelspause, så vælg ottendedelen og klik på/tast 0 (nul) på Key-
pad’et; en pause af valgt længde indsættes og markøren rykker videre, klar til næste 
node/pause. Punkteringer laves ved at vælge punkteringen (komma-tast på num-pad) 
sammen med nodeværdien, og så indsætte noden. Punkteringen kan også tilsættes sene-
re. Bindebuer (Enter på keypad’et) sættes på lige efter den node hvor buen starter. Kan 
også tilføjes efterfølgende ved at markere den første node og vælge bindebuen. 

3.2. Trioler og andre ”- oler” (triplets) 

Trioler laves således: Indsæt første node, med den nodevær-
di der skal være basis i triolen, altså en fjerdedelsnode til en 
fjerdedelstriol. Tast Ctrl + 3 / ⌘ + 3 (på det alm. tastatur). 
Tilsvarende tastes tallene fra 2 til 9 for at få alt fra hhv. 
duoler til nonioler. 

3.3. Becifringer 

Indsæt becifringerne efter forlægget. 
Brug samme metode som i afsnit 2.13. 

3.4. Volter (Endings) 

Volter indsættes således: Vælg Notati-
ons > Lines (L). I denne menu findes en 
lang række ”objekter der går på langs 
af nodesystemet” og altså kan betragtes 
som en form for linjer; enkelte af dem 
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har sine egne tastegenveje. Volterne er øverst til højre. Vælg den rigtige og klik OK. 
Med den nu ladte musemarkør klikkes i starten af den takt hvor volten skal være over. 
En alternativ metode er først at markere takten og dernæst gå i Lines-dialogen og vælge 
volten. Volterne kan trækkes på plads med musen, eller man kan markere forskellige 
steder på volten og bruge piletaster til at få den på plads. 

3.5. Gentagelsestegn og dobbeltstreger  

Begge er at finde i Notation > Common > hhv. Start Repeat, End Repeat og Double. En-
ten kan man markere den aktuelle taktstreg i noden og så vælge tegnet/dobbeltstregen 
i menuen, eller i omvendt rækkefølge. 

3.6. Sangtekst fra eksternt dokument 

En ganske smart måde at indsætte sangtekst er at kopiere den ind fra et dokument i et 
tekstbehandlingsprogram. Hvis man f.x. har fundet teksten på internettet og kopieret 
den ind i et Word-dokument, har man her mulighed for at rette den til, hvorefter man 
følger nedenstående fremgangsmåde.  

1. Åbn tekstfilen (Elefantens Vuggevise tekst.rtf) i f.x. Word. Marker første vers af 
teksten og kopier den til udklipsholderen (Ctrl + C / ⌘ + C).  

2. Skift over til Sibelius (Alt + Tab / ⌘ + Tab) og åbn opgavefilen. 
3. Marker første node.  
4. Tast Ctrl + L / ⌘ + L, herved fremkommer tekstmarkør.  
5. Nu tastes Ctrl + V / ⌘ + V (Paste), hvormed første stavelse af den kopierede 

tekst (”Nu”) skulle blive indsat.  
6. For hver stavelse skal nu tastes Ctrl + V / ⌘ + V (Paste).  

Sibelius går selv videre til næste tone og kan endda dele ordene korrekt – så længe det 
er engelsk! Er det f.x. en dansk tekst er det nødvendigt selv at indsætte bindestreger i 
tekstfilen forud for kopieringen, for at undgå nogen til tider ret ulæselige orddelinger. 
Når man når til en overbundet node, hvor en stavelse skal fordeles over flere toner, ta-
stes Mellemrum eller bindestreg, til den næste stavelse skal indsættes. Tilsvarende er 
der et par steder, hvor der ikke er lige mange stavelser i de to vers; der må man tilpasse 
lidt! Det er nødvendigt at være temmelig opmærksom på dette, da det er nemt at lave 
en fejl. Skulle det gå galt, så brug Undo! Tast Ctrl + Z / ⌘ + Z eller klik på den venstre 
buede pil i værktøjslinjen, indtil det ser rigtigt ud igen. Hvis det er gået galt må man 
tilbage til tekstfilen og kopiere teksten igen, minus den del man allerede har indsat rig-
tigt. Men med lidt øvelse er dette en meget effektiv måde at indsætte tekst.  

3.6.1 Lyrics line 2 
Andet vers (linje 2) indsættes på tilsvarende måde, dog vælges Text > Lyrics > Lyrics 
line 2 (Ctrl + Alt + L / ⌘ + ⌥ + L). Denne teksttype er defineret til at stå et passende 
stykke under linje 1. I starten af første vers står der i forlægget et diskret ”1.” som an-
givelse af dette er første vers, tilsvarende ved andet vers. For at få et mellemrum ind 
mellem tallet og det første ord uden at hoppe videre til næste ord, bruges et såkaldt 
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”Nonbreaking space”. Dobbeltklik på ”Nu” i første linje og placer indsætningspunktet til 
venstre for ordet. Indtast ”1.” og tast Tab (tasten for oven til venstre med ”➝|”). 
Samme metode ved vers 2.  

3.6.2 Block Lyrics 
Vers tre og fire laves med teksttypen ”Block Lyrics”:  

1. Gå tilbage til tekstdokumentet og kopiér vers tre og fire.  
2. Vælg Text > Lyrics > Block lyrics.  
3. Klik med musen under sidste nodesystem og ”paste” teksten ind.  

Den vil nok først stå med samme skrifttype som i tekstdokumentet. Tast Esc i det du 
sikrer dig, at teksten stadig er markeret. Åbn fanen Text. I det venstre panel kan du 
vælge font og størrelse af tekst. Under Font vælges fonten ”Inkpen 2 Script” og se din 
tekst med den rette skrifttype. 

3.7. Flip  

Skulle du ønske at vende nogen af triol-klammerne, så de giver bedre I så fald kan man 
prøve den funktion der hedder ”Flip”: marker klammen og vælg fanen Home > Edit > 
Flip (X). Så skulle den gerne hoppe op over systemet. Denne funktion kan bruges på 
mange objekter der kan vende enten opad eller nedad, f.x. nodehalse, dynamik-fisk, 
fraseringsbuer osv. 

3.8. Fermat 

Den afsluttende fermat findes på 1-tallet i Keypad’ets layout 4 (F 10). Marker tonen, 
vælg 4. layout og tast 1.  

3.9. Parenteser om toner 

Der findes en dedikeret ”node-parentes” på Keypad’ets layout 2 (F8), igen på 1-tallet. 
Tilsvarende fremgangsmåde. Læg mærke til at der også er en parentes at finde på Key-
pad’ets sjette layout (F12), på Entertasten. Denne tast indsætter ”hjælpe-fortegn”, 
med parentes om. 

3.10. Afstand mellem nodesystemer 

Sibelius har en indbygget funktion til at justere linjeafstand: 
markér hele noden (Ctrl + A / ⌘ + A), og vælg fanen Layout > 
Optimize. I en længere node tager det et par sekunder. Alter-
nativt er her en nem måde manuelt at justere afstanden mellem 
systemerne: Trippel-klik i øverste linje; herved markeres instru-
mentet i hele nodens længde. Træk herefter i øverste linje, stille 
og roligt. Nu ændrer linjeafstanden sig jævnt i hele noden. 
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3.11. Antal takter pr. system/System Break 

I forbindelse med arbejdet med Elefantens vuggevise, har du sikkert oplevet at der er et 
andet antal takter pr. system end i forlægget. Sibelius optimerer selv dette ud fra for-
holdet mellem tekst og noder. Det er dog også muligt at tvinge et bestemt an-
tal takter ind i hvert system. Dette gøres med funktionen Make into system, 
som findes under Lay outfanen > Format yderst til højre (Alt+shift+M). Marker de takter 
der skal indgå i systemet (gøres lettest ved at markere den første takt og med Shift-
tasten nede markere den sidste) og klik Make into system. Dette vil tvinge takterne 
sammen på en linje. Gør det samme med resten af noden for at få det ønskede resultat. 

3.12. Opgave 1 

Med udgangspunkt i vejledningen til ”Den næste node” skal du gøre sangen ”Elefantens 
Vuggevise” færdig. Brug pdf-filen af samme navn som forlæg. Aflevér opgaven som [dit 
navn] opgave 1 Elefanten. sib under Lektion 1. 

4. Indspilning af korsats med FLEXITIME + Polyfoni 

Forlæg: White Christmas  
Hjælpefil: White Christmas_HLP.sib 
 

4.1. Voices 

For at kunne have to eller flere indbyrdes uafhængige melodilinjer i den samme nodelin-
je, som f.x. sopran og alt i forlægget ”White Christmas”, findes i Sibelius funktionen 
”Voices”. Almindeligvis arbejder man i Voice 1, og oftest indsætter man noder i Voice 1 
først. Når man så efterfølgende indsætter noder i Voice 2, vil noderne i de to Voices 
vende nodehalsene hver sin vej – Voice 1 opad, og Voice 2 nedad. I samme nodelinje kan 
indsættes op til 4 uafhængige stemmer, 
Voice 1 til 4. De er farvekodede således: 
V. 1 er  blå, som vi indtil videre har set 
det, V. 2 er grøn, V. 3 orange (nodehalse 
opad) og V. 4 violet/pink (nodehalse ned-
ad). Knapperne nederst i keypad-vinduet refererer hertil. Det er vigtigt at forstå, at 
betegnelsen ”Voice” ikke har noget med de arrangementsmæssige stemmer, der findes i 
noden at gøre; det handler ikke om at alten eller andenviolinen skal skrives i Voice 2, 
fordi den rent musikalsk har andenstemmen. Det refererer udelukkende til hvor mange 
uafhængige melodilinjer der findes i den enkelte nodelinje; m.a.o. giver man sig nor-
malt først til at benytte andet end Voice 1, når man har flere instrumenter i samme 
linje OG de ikke følges ad rytmisk (er polyfone). At benytte Voice 3 og 4 vil typisk in-
dikere et ganske komplekst og ret sjældent musikalsk scenarie! I den foreliggende opga-
ve findes sopranstemmen allerede. Når man ønsker at tilføje en melodilinje mere i 
samme system, skal den altså indsættes i Voice 2.  
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HVERT SYSTEM KAN HAVE OP TIL FIRE VOICES. DET ER ALTSÅ IKKE SÅDAN AT ET KORPAR-
TITUR HAR VOICE 1 + 2 (SOPRAN/ALT) I ØVERSTE SYSTEM OG VOICE 3 + 4 (TENOR/BAS) I 
NEDERSTE! I BEGGE TILFÆLDE VIL DET VÆRE VOICE 1 + 2. 

4.2. Voice 2 med Steptime 

Åbn hjælpefilen White Christmas.sib i Sibelius. Filen er lavet på ska-
belonen Choir Reduction. Sopranstemmen er indspillet i forvejen i 
Voice 1 og du skal nu indsætte alt-stemmen i Voice 2 ud fra forlæg-
get. Nederst i Keypadvinduet findes 5 knapper. De første 4 har talle-
ne 1 – 4. Her vælger man hvilken af de 4 Voices man vil arbejde med. 
De virker tilsvarende de øvrige knapper i Key-pad’et: hvis man mar-
kerer en node og trykker på en af knapperne, ændrer noden sig til 
den nodeværdi eller Voice man trykker på. Hvis man nu markerer 
første node i sopranen og blot vælger Voice 2 fra Keypad’et, vil den 
valgte node hoppe over i Voice 2. For i stedet at tilføje en ny node til 
systemet og samtidigt beholde den eksisterende i Voice 1 må man  

1. Markere noden  
2. derefter vælge Note Input > Input Notes (N). Derved får man indsætningsmarkøren 

frem igen.  
3. Herefter vælges Voice 2 – knappen på Keypad’et (genvej: Alt + 2 / ⌥ + 2 på hovedta-

staturet). Markøren bliver herved grøn, symboliserende Voice 2.  

Nu kan alt-stemmen indsættes vha. taster eller klaviatur. En alternativ måde er:  

1. Start med at sikre at intet er valgt (tast Esc to gange).  
2. Vælg fjerdedel fra keypad’et og derefter Voice 2.  
3. Indsæt første node med musen. Herefter kan fortsættes med mus, taster eller klavia-

tur. 
4.3. Tenor/Bas med Flexi-time 

Du skal nu indspille tenorstemmen med Fle-
xi-time. Flexi-time er Sibelius’ betegnelse 
for at indspille musik i real-time vha. et MI-
DI-keyboard. Ordet Flexi-time indikerer, at 
programmet kan følge brugerens tempoud-
sving. Først må man indstille funktionen til 
den forhåndenværende opgave. Det sker i 
fanen Note Input > Flexi-time. Klik på pilen i 
nederste højre hjørne for at åbne Flexi-time 
Options (Ctrl + Shift + O / ⌘ + Shift + O), 
som har to faner. Den første,”Flexi-time,” 
indeholder en rullemenu, som indstiller før-
nævnte tempofleksibilitet. Umiddelbart an-
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befales ”None”, men ”Low” skulle også virke fint. Tallet ud for ”Introduction” angiver 
hvor lang fortælling man får før indspilningen starter. ”Record up to” angiver hvor man-
ge takter der skal afsættes hukommelse til pr. indspilningssession. 100 plejer at være så 
rigeligt! 

Til højre findes feltet ”Voices”. Et flueben i ”Record into multiple voices” tillader pro-
grammet selv at afgøre, hvorvidt det er formålstjenligt at opfatte det indspillede som en 
eller flere Voices. Fjern fluebenet, hvis det er der. Herunder skal der for nu være mar-
kering i Voice 1. I feltet under igen skal der være flueben i ”Click when recording” (me-
tronom under indspilning: ja tak). Den 
anden fane, ”Notation”, indeholder en 
slags ”præ-kvantiserings-indstillinger”, 
altså oplysninger om hvordan det vi spil-
ler på keyboardet skal realiseres i no-
der, og en god mulighed for at mindske 
behovet for rettelser bagefter. Feltet 
”Note Values” giver mulighed for at an-
give mindste ønskelige nodeværdi; i 
dette tilfælde skal vi ikke bruge node-
værdier kortere end ottendedele. Klik i 
rullemenuen og vælg dette. Hvis der er 
flueben ud for ”Staccato” og ”Tenuto”, 
så plejer jeg selv at fjerne dem. Det er 
rarest selv at bestemme præcis hvor der 
skal være prikker og streger. I feltet 
”Tuplets” kan Flexi-time få lov at opfatte det indspillede som diverse polyrytmer. I det-
te tilfælde skal vi ikke bruge nogen polyrytmer, så sæt alle rullemenuer til ”None”. Klik 
”OK”. 

Nu skal du indspille tenorstemmen til ”White Christmas”. Tenoren skal have nodehalsene 
opad, altså Voice 1. Vi har netop sat Flexi-time til at skrive noderne i Voice 1, så OK. 
Man kan øve stemmen på flg. måde: Marker tenorstemmen – herved aktiveres den stem-
mes afspilningslyd på keyboardet. Klik så et tomt sted på arket eller tast Esc to gange 
for ikke at have markeret noget (derved undgås at sætte noder ind!). For at indspille:  

1. Markér første takt i 2. linje. Hav forlægget klar, og vælg Note input > Flexi-time > 
Record (Ctrl + Shift + F / ⌘ + Shift + F) eller klik på den røde optage-knap i Play-
back-vinduet.  

2. Nu tælles der for (metronom-klik) hvorefter du indspille tenorstemmen på MIDI-
keyboardet. Hvis det går for hurtigt, kan tempoet reguleres i Playback-vinduets sky-
deknap nederst til højre (Ctrl+alt+Y).  

Tjek efter at tenorstemmen ser ud som på forlægget, og ret evt. fejl, enten ved at klik-
ke på de forkerte noder og rette dem manuelt, eller evt. ved at gøre indspilningen om! 
Basstemmen indspilles på tilsvarende måde, dog skal feltet ”Voices” i Flexi-time Opti-
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ons-dialogen have markering i Voice 2. Læg mærke til at først når der kommer Voice 2-
noder i systemet svipper Voice 1 nodehalsene opad! 

Efter endt indspilning og evt. korrektur: tast Esc et par gange og tast mellemrum, P eller 
klik på afspilningsknappen i Playback-vinduet – og nyd Irwing Berlins smukke melodi og 
harmonisering. 

4.4. Enharmonisk omtydning 

Sibelius er ikke altid i stand til at vælge de rigtige fortegn. Hvis en skalafremmed tone 
er noteret med et b (fx Eb) og skulle have været noteret med et # (D#) gøres således for 
at lave enharmonisk omtydning: Vælg tonen og tast return (på hovedtastaturet) – den 
bliver nu til D#. Det virker selvfølgelig også den anden vej (# >b). 

4.5.  Opgave 2 

Gør White Christmas korsatsen færdig og aflevér den færdige fil som opgave 2 med nav-
net [dit navn]White x-mas.sib. 

5. Avancerede arrangementsfunktioner 

Forlæg: You can call me Al og Is this love 
Hjælpefiler: You can call me Al_HLP.sib og Is this love_HLP.sib  

5.1. Explode 

Sibelius har flere funktioner der automatiserer forskellige arrangementsopgaver. To af 
dem forklares i det følgende. EXPLODE – at eksplodere et arrangement vil sige at fordele 
stemmer fra et system til enkeltsystemer. Har man f. x. indspillet en trestemmig figur 
via sit keyboard kan Sibelius ekspodere stemmerne ud på 3 systemer, som kan spilles af 
f.x. tre blæsere. Det er dog meget vigtigt, at der i den originale figur overalt kun er det 
antal stemmer, der svarer til det antal systemer stemmerne skal fordeles på.  

Følg denne fremgangsmåde for at løse opgaven ”You can call me al”: 

1. Åbn først forlægget ”You can call me al”. Filen indeholder den færdige node, som 
den skal se ud når du har løst opgaven. Skift som sædvanlig mellem denne fil og Sibe-
lius v. hj. af alt+tab. 

2. Åbn derefter filen “You can call me al ½ OPGAVE” i Sibelius. Dette er den halvtud-
fyldte node ud fra hvilken du skal lave opgaven. Prøv 
at afspille noden. Bemærk at der er tromme/bas-
akkompagnement som en ny service fra læreren. 
Stemmerne er skjult men man kan få dem frem ved at 
klikke på symbolet Focus on staves under fanen Lay-
out > Hiding Staves (Ctrl+Alt+F). Med denne funktion 
kan umarkerede systemer skjules men stadig høres 
ved afspilning. 
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3. I systemet Horn er et trestemmigt blæserarrangement. Det skal for-
synes med artikulationstegn som i forlægget. Dette gøres ved at 
markere de noder der skal have tenuto- og staccatotegn og derefter 
indsætte fra Key-pad’ens tegn menu. 

Når dette er tilendebragt skal de tre stemmer eksploderes. Gør følgende: 

1. Markér hele hornsystemet (trippelklik) og kopier det (ctrl+C).  
2. Marker derefter de 3 systemer trompet, altsax og trombone. 

Markering af takt 1 rækker. 
3. Find fanen Note Input og underpunktet Arrange.  
4. Vælg Explode og iagttag hvordan stemmerne fordeler sig – med 

artikulationstegn. 

Smart ikke? 

OBS! Det er meget vigtigt, at der i den originale figur overalt kun er det antal stemmer, 
der svarer til det antal systemer stemmerne skal fordeles på. Ellers kan Sibelius ikke ud-
føre tricket. 

5.2. Reduction 

At reducere (også kaldet at implodere) er at gøre det præcis omvendte, nemlig samle 
flere stemmer i et eller 2 systemer (klaverpartitur). Det kan f.x. være belejligt, hvis 
man ikke er god til at læse partiturer eller hvis man har undladt at lave sine stemmer i 
en samlet klaverudgave. 

Følg denne fremgangsmåde for at løse opgaven ”Is this love”. 

1. Åbn først forlægget ”Is this love”. Filen indeholder den færdige node, som den skal 
se ud når du har løst opgaven. Skift som sædvanlig mellem denne fil og Sibelius v. hj. 
af alt+tab. 

2. Åbn derefter filen “Is this love ½ OPGAVE” i Sibelius. Dette er hjælpefilen ud fra 
hvilken du skal lave opgaven. 
 

5.2.1 Reinput pitches 
Som det fremgår mangler korstemmen i nederste system. Med funktionen re-input pit-
ches kan man kopiere en stemme og erstatte tonerne ved hjælp af tastatur eller key-
board. Gør følgende:  

1. Marker 1. st- systemet (trippelklik) og kopier til system 3 ved holde alt-
tasten ned og klikke i begyndelse af takt 1 i det nederste system. 

2. Marker den første node i dette system og vælg Note Input > Reinput pit-
ches  (alt+shift+N) 

3. En stiplet markør angiver at man kan ændre tonehøjden på noderne fra 
keyboardet/tastaturet. Bare tast de rigtige toner/tonenavne – Sibelius 
hopper selv videre til næste tone. 

  



18 
 

©2014 bjørn bønne petersen          Nodeskrivning med Sibelius 7.5 

4. Indsæt i overensstemmelse med forlægget. 

5.2.2 Implode/Reduce 
Når dette er tilendebragt skal de tre stemmer reduceres/imploderes. Gør følgende: 

1. Marker de tre vokalsystemer og kopier dem (ctrl+C).  
2. Marker derefter de to øverste Kor-systemer (G+F-nøgler) 
3. Find fanen Note Input og underpunktet Arrange (ctrl+shift+V).  
4. Vælg Arrange (ikke reducti-

on, da du først skal vælge på 
hvilken måde der skal redu-
ceres).  Vælg underpunktet 
Choose Arrange Style. 

5. Find den Style der hedder 
Keyboard Reduction up to 2 
voices per staff og iagttag 
hvordan stemmerne samles 
på 2 systemer – med tekst. 
Bemærk at melodien som er 
en herrestemme skrives i F-
nøglen og at 1. + 2. stemmen 
skrives i G-nøglen som voice 1 og 2.  

Ret smart ikke? 

5.3. Kopiering 

Almindelig Copy/Paste fungerer fint i Sibelius, men der er en nemmere måde at gøre det 
på. Her skal nævnes en af dem.  

1. Marker først det objekt du vil kopiere (becifring eller tekst):  
2. Vælg Home > Select > More (Ctrl + Shift + A / ⌘ / Shift + A). Dette markerer resten 

af akkorderne/teksten i samme linje.  

Evt. kan man nu flytte hele tekstlinjen på plads op eller ned, hvis man synes; brug pile-
taster. Man kan også få objekterne til at flugte, hvis de ikke står på linje. Det foregår 
under Appearance > Align > Row (Ctrl+shift+R).  

Selve kopieringen foregår ved at holde Alt-tasten nede og klikke på første node af den 
linje, hvor akkorderne/teksten skal kopieres til. Med andre ord: det der er markeret ko-
pieres med Alt-klik øjeblikkeligt til det sted hvor man klikker. Det gælder langt de fleste 
objekter i Sibelius.  

6. Videregående leadsheet – I do it for your love 

Forlæg: I do it for your love (E dur) og I do it for your love (F dur) 
Hjælpefiler: I do it for your love opgave.sib og I do it for your love.rtf 
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Formålet med denne opgave er at foretage ændringer i hjælpefilen I do it for your love 
så den kommer i overensstemmelse med forlægget i PDF-dokumentet. Åbne hjælpefilen 
i Sibelius og forlægget. 

6.1. Filter og Stiknoder (Cue Notes) 

Stiknoderne i de to øverste linjer laves ad to omgange. Først skal noderne vælges, og 
her introduceres værktøjet ”Filter”. Det bruges til at præcisere en markering (”selecti-
on”), sådan at den næste handling påvirker præcis det man vil arbejde på.  

1. Marker takt 4 – 7 og vælg fanen Home > Filter > Voices > Voice 1 (Ctrl + Shift + Alt + 
1 / ⌘ + ⌥ + Shift + 1). Nu er Voice 1 markeret i de fire takter.  

2. For at undgå at påvirke becifringerne 
vælges Home > Filter > Notes and 
Chords.  

3. Tast F8, så keypadlayout # 2 kommer 
frem.  

4. Klik her på nederste højre knap (Enter på keypad’et). Det skulle formindske de valgte 
noder til stiknodestørrelse.  

En anden type stiknoder bruges i takt 9 og 10 til at angive hvilke af tonerne i treklange-
ne der er hhv. korstemmer og melodistemme. De laves vha. forskellige nodehoveder, 
sådan:  

1. Først skal noderne igen vælges 
ud. Marker første treklangsnode, 
på 2. slag af takt 9. Shift-klik et 
tomt sted i takt 10. Nu skulle alle treklangsnoderne gerne være mar-
keret.  

2. Vælg Home > Filter > Notes in Chords (For Copying) > Top Note (Ctrl 
+ Alt + 1 / ⌘ + ⌥ + 1). Nu er kun øverste node af treklangene mar-
keret.  

3. Gå til fanen Notations > panelet Noteheads > Type. Rullemenuen 
rummer 32 forskellige nodehoveder, hvoraf en del ser ud til at være 
ens. De har forskellige egenskaber mht. afspilning, funktion i trom-
menoder osv. Den vi gerne vil have fat i nu er nr. 10 Small, som er i 
stiknode-størrelse – vælg den, og de markerede nodehoveder krym-
per til stiknodestørrelse.  

4. Udvælg på tilsvarende måde de midterste noder af treklangene 
(Home > Filter > Notes in Chords (For Copying) > 2nd Note (Ctrl + Alt 
+ 2 / ⌘ + ⌥ + 2) og gør det samme ved dem.  

Nodehovederne har også tastegenveje: Shift + Alt + nodehovedets num-
mer, på hovedtastaturet. Ved tocifrede numre tastes de to cifre efter 
hinanden mens man holder Shift + Alt nede.  
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6.2. Crescendo /diminuendo - linjer og fraseringsbuer  

Dynamik-”fiskene” i første og anden linje indsættes således: Marker første node i 4. takt 
og vælg Notations > Lines (L). Klik på pilen i nederste højre hjørne. I denne dialog (hvor 
flere tastegenveje er vist) vælges først crescendo (H for Hairpin). Klik OK, og ”fisken” 
skulle komme frem det rigtige sted. Nu tastes Mellemrum, og for hvert tryk springer 
højre ende af linjen en node frem. Man kan også taste højre/venstre piletast eller Ctrl 
+ piletast / ⌘ + piletast for at finjustere (begge metoder kræver at højre ende af linjen 
er markeret). Diminuendo-”fisken” laves på tilsvarende måde (Shift + H).  

Fraseringsbuerne i 6.-7.-takt og igen i takt 10 laves sådan: marker noden hvor buen skal 
starte og vælg igen Notations > Lines (L) eller tast S for slur.( Bemærk forskellen mel-
lem fraseringsbuer (slurs) og bindebuer (ties)! ) Fraseringsbuer forlænges på samme 
måde som crescendo/decrescendo tegn. Disse buer er ”magnetiske”, dvs. at de følger 
med op og ned hvis tonehøjden ændres. Fraseringsbuer kan flippes ligesom nodehalse 
med tryk på X.  

6.3. Kopiering (igen) 

En af de hurtigste måder at skrive noder på er at kopiere nogen man allerede har skre-
vet! Det anbefales hermed at gøre dette så meget som muligt. I denne opgave skal B-
stykket kopieres til et sted længere henne i noden; efter dobbeltstregen efter solo-
stykket. Marker B-stykket (klik i første takt, Shift-klik i sidste takt) og sæt ind med Alt-
klik efter Soloen. En anden nem kopieringsmetode afsløres i afsnittet ”Rytmeskråstre-
ger”. 

6.4. Modulation (ny toneart) 

Før det nylig kopierede B-stykke virker helt, skal det stå i Db-dur. Tast Esc, så intet er 
markeret, og vælg fanen Notations > Common > Key Signature (K). Denne dialog er ma-
gen til den i New Score-dialogen. Vælg Db-dur, klik OK og indsæt den nye toneart i star-
ten af B-stykket med den blå pil. Det er bedst at klikke helt i starten af linjen, oven i de 
gamle fortegn. Så placeres de nye fortegn helt rigtigt. Indsæt på samme måde E-dur 
igen i starten af Codaen. 

6.5. Rytmeskråstreger/Slashes 

I leadsheets og til akkordark bruges ofte skråstreger (slashes) til at indikere pulsen. Disse 
skråstreger skal indsættes i opgavens Solo-stykke. De er i virkeligheden en slags fjerde-
delsnoder, blot med et andet nodehovede. Indsæt en fjerdedelsnode på 1-slaget i første 
takt af solostykket. Det ser pænest ud med tonehøjden B i midten af systemet. Undgå 
løst fortegn. Marker noden (hvis du lige har indsat den, tast da venstre piletast én gang). 
Gå igen til fanen Notations > panelet Noteheads > Type. Denne gang skal vi bruge nr. 3. 
Den ligner meget nr. 4, men denne har hals på i modsætning til nr. 3. Vælg nr. 3, hvor-
ved vor nye node skulle blive til en skråstreg. Her følger endnu en kopieringsmetode: 
med den nye skråstreg stadig markeret, vælg Note Input > Repeat (R). Denne kommando 
gentager det valgte umiddelbart til højre. Lav tre nye streger på denne måde. Klik nu et 
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tomt sted i takten og vælg Repeat igen. Nu gentages hele takten. Man kan markere og 
gentage lige så mange takter ad gangen som man vil, så vel som mange andre objekter. 

6.6. Rehearsal Marks 

Rehearsal Marks er en skrifttype lavet til bogstaver eller tal i 
kasser til at markere star ten af stykkerne. Der er en indbygget 
funktionalitet som gør, at hvis man bruger bogstaver som styk-
kebetegnelser vil de følge alfabetet fortløbende. Tal optræder 
naturligvis i numerisk rækkefølge. Det er også muligt at bruge 
takttallet som udgangspunkt for betegnelsen.  

1. Tast Esc så intet er markeret 
2. Tast Ctrl + R / ⌘ + R. Nu bliver pilen ladt.  
3. Klik i starten af tredje linje og indsæt herved det første Re-

hearsal Mark.  
4. Indsæt de næste ifølge forlægget.  

Når man når til andet B-stykke, er det nødvendigt at omgå den indbyggede funktionali-
tet for at kunne indsætte et B efter C. Vælg Text > Rehearsal Mark (tast evt. Esc først). 
Denne dialog har øverst to valgmuligheder: Consecutive og Restart Sequence. Den første 
betyder fortløbende og giver samme resultat som tastegenvejen. Vælg Restart Sequence 
og derefter ”Start at” og skriv B i feltet. Klik OK og indsæt B’et i starten af andet B-
stykke. Hvis man nu valgte at indsætte flere Rehearsal Marks efter dette vha. tastegen-
vejen ville de atter følge alfabetet fortløbende.  
Rehearsal marks er låst i deres vandrette og lodrette position, hvilket medfører at de 
kan komme til at stille sig oven i eksisterende tekst. For at ændre: markér det Rehearsal 
Mark du vil flytte, hold Ctrl + Alt / ⌘ + ⌥ nede og træk med musen. 

6.7. Dal segno og Coda tegn 

Dal segno og Coda og andre navigationstegn findes under fanen Notations > Symbols. 
Bemærk at Sibelius kan afspille noder og følge disse tegn, men kun hvis de er indsat fra 
Notations panelet. Teksthenvisninger som To Coda findes under Text > Styles.  

6.8. Tekst/Lyrics 

Indsæt teksten fra hjælpefilen I do it for your love.txt. 
Brug samme fremgangsmåde som ved Elefantens Vugge-
vise  3.6. 

6.9. Transposition 

Hvis man nu har lavet sin node fiks og færdig, men fin-
der ud af at den skal stå i en anden toneart – så må man 
jo transponere! Det er heldigvis ganske enkelt i Sibelius. 
Markér alt (Ctrl + A / ⌘ + A) og vælg Note Input > 
Transpose (Shift + T). I dialogboksen er der to forskelli-
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ge måder at gøre det på, enten vælger man den ny toneart og hvorvidt tonerne skal flyt-
tes op, ned eller bare den nærmeste vej, eller også vælger man hvilket interval noderne 
skal flyttes og programmet regner den ny toneart ud for os. Man kan også vælge at flytte 
noderne, men uden at skifte toneart. Endelig kan man tillade at der i den nye toneart 
bruges dobbelt-fortegn (gys!). Efter transposition kan man komme ud for at skulle tilpas-
se fortegnene lidt. Enharmonisk omtydning gøres ved at markere tonen og taste Return. 
Becifringer omtydes vha. Text > Chord Symbol > Respell Chord Symbol. 

7. Leadsheet 2 – Let Love Rule (sammenfletning af filer) 

Forlæg: Let love rule 
Hjælpefiler: Let love rule_LEAD, Let love rule_KOR, Let love rule_RYT 

7.1. Om at skjule tomme systemer (Hide empty staves) 

I Sibelius kan man have flere systemer aktive, men de kan skjules når de er tomme. Det 
kan være aktuelt, når stemmer kun optræder lejlighedsvist. Følgende proces beskriver 
hvordan man kombinerer 3 Sibeliusfiler og derefter skjuler de tomme systemer og der-
ved får et komplet arrangement med Lead, kor og rytmegruppe i et og samme nodedo-
kument. 

1. Åbn først PDF-filen Let love rule. Dette er dit forlæg ud fra hvilket du skal løse opga-
ven. 

2. Åbn Sibeliusfilerne Let love rule LEAD, Let love rule KOR og Let love rule RYT 
7.2. Instruments - dialogboksen 

Opgaven går nu ud på at få Let Love Rule LEAD-noden til at ligne forlægget så meget 
som muligt. Der mangler jo en del instrumenter, og de skal nu tilføjes.  

1. Vælg fanen Home > Instruments (I). [Denne dialogboks kommer man i øvrigt også til 
via New Score-proceduren, hvis man klikker på knappen Change Instruments.] Den er 
opbygget hierarkisk: i øverste venstre hjørne vælger man mellem forskellige gruppe-
ringer af de instrumenttyper, der er til rådighed. Herunder er disse instrumenter så 
opdelt i nogle ganske logiske ”familier”, og endelig til højre herfor vælges det enkel-
te instrument ud. Med et instrument markeret klikker man ”Add to score”. Fluks 
dukker det op i listen til højre, som er en præcis forsmag på hvordan instrumenterne 
vil optræde i noden. Man kan markere instrumenterne i listen, og vha. ”Move 
Up/Down” kan man ændre rækkefølgen. 

2.  Indsæt flg. instrumenter: Kor (Choir), orgel (organ), guitar, bas og trommer. Kor-
stemmen kan vælges frit mellem de forskellige typer vokal (fx voice).  

3. Orgelstemmen vil indeholde to linjer; såvel diskant- som basnøgle. Vi skal kun bruge 
den med diskantnøglen. I listen til højre vælger man den nederste stemme (”B”) og 
klikker på ”Delete from Score”.  

4. Når listen ser ud som på billedet, klikkes OK. Husk at gemme din fil under nyt navn!  
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5. Slet instrumentnavnene ud 
for øverste system – dem får 
vi ikke brug for. Slet også 
navnet på korstemmen i an-
det system, og ret de øvrige 
forkortede instrumentnavne 
til sammesteds. Det gøres 
ved at dobbeltklikke på nav-
nene.  

6. Slet den runde ene klamme 
ud for orgelsystemet, og ret 
den kantede klamme til så 
den dækker alle fire instru-
menter: tag fat med musen i 
hjørnerne og træk den til 
den rigtige størrelse og placering.  
 
7.3. Kopiering fra en Sibeliusfil til en anden 

I denne opgave skal vi hente de resterende elementer til leadsheetet fra to andre doku-
menter. Kopiering mellem dokumenter foregår vha. god, gammeldags Copy/Paste.  

7.3.1 Indkopiering af korstemmer 
1. Åbn Let Love Rule KOR.  
2. Marker alle 4 takter, kopier dem 
3. Gå tilbage til LEAD-noden.  
4. Marker her, i korstemmen, første takt af omkvædet.  
5. Indsæt (”paste”) det kopierede. Tilføj fraseringsbuen.  

7.3.2 Indkopiering af instrumentstemmer 
Så skal vi indsætte rytmepartituret. Eftersom det skal stå til sidst i noden, og være uaf 
hængigt af det foregående, skal det placeres efter resten af noderne. For at vi kan kopi-
ere det ind, skal vi bruge en ekstra takt til sidst.  

1. Vælg fanen Home > Bars > Add > At End (Ctrl + B / ⌘ + B).  
2. Åbn RYT-noden.  
3. Marker hele øverste linje (trippelklik), og Shft-klik i nederste 

linje. Nu skulle hele noden være markeret med enkelt blå 
ramme.  

4. Kopiér.  
5. Gå tilbage til LEAD-dokumentet.  
6. Marker den nye sidste takt, i orgel-stemmen.  
7. Indsæt det kopierede.  

Nu skulle de nødvendige ekstra takter dukke op af sig selv, med det kopierede i. 

  



24 
 

©2014 bjørn bønne petersen          Nodeskrivning med Sibelius 7.5 

7.4. Hide Empty Staves 

Denne funktion er den der får noden til at se ud som vi gerne vil have det. Alle helt 
tomme nodelinjer bliver skjult. Symbolet for en helt tom takt er helnode-pausen i mid-
ten af takten, i øvrigt uanset taktart. Som noden ser ud nu, er der i de første 3 systemer 
kun leadsang. I næste system kommer koret på, men stadig er rytmegruppestemmerne 
helt tomme. De bliver altså gemt væk ved denne funktion. Tilsvarende, til sidst, hvor 
sangstemmerne er tomme er det dem der bliver gemt væk.  

1. Marker alt (Ctrl + A / ⌘ / A). 
2. Vælg Layout > Hide Empty Staves (Ctrl + Alt + Shift + H / ⌘ + ⌥ + Shift + H). Vupti – 

noden fylder kun en side. I modsat fald kan man justere lidt i Staff Size (se neden-
for). Indsæt for god ordens skyld lige en modulation til E-dur i første takt af rytme-
partituret, og tilbage til G-dur i femte takt. I begge tilfælde ser det bedst ud, hvis 
man i ”Key Signature”-boksen sætter flueben i ”Hide” nede til venstre; så undgår 
man for mange informationer. 

7.5. Guitardiagrammer (og lidt om becifringer) 

Guitardiagrammer findes i Sibelius inden i den samme funktion som becifringssymboler. 
Ofte vil en guitarstemme være sat til automatisk at have diagrammer sammen med hver 
becifring. Vi skal her indsætte to diagrammer i rytmepartituret.  

1. Marker første node i guitarstemmen og vælg fanen Text > Chord Symbols (Ctrl + K / 
⌘ + K) som sædvanligt.  

2. Indtast ”E7” og tast Mellemrum. Der skulle gerne dukke både becifring og diagram 
op. Gør det samme i takt 3 ved G7. 

3. Markér E7 diagrammet og klik på Revoice Chord Diagram (Ctrl + 
Alt + Shift + K / ⌘ + ⌥ + Shift + K) indtil diagrammets voicing 
stemmer overens med noden. Kig evt. efter forlægget. Gør det 
samme med G7 diagrammet.  

4. Markér begge guitardiagrammer og vælg Add/Remove og vælg 
Chord Text for kun at vise diagrammet uden becifringen. 

Alternativt kan du designe dit eget med Edit Chord Diagram. 
Denne editor er ganske enkel at bruge. Klik løs med musen og 
forsøg dig frem. Barré laves med klik-og-træk. De små pileknap-
per til højre flytter akkorden op og ned i båndene. OSB: der er ingen indbygget kontrol, 
så man skal selv vide at grebet er rigtigt! Kontrolcenteret for hvordan becifrin-
ger/diagrammer opfører sig er House Style  Edit  Chord Symbols… 
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8. Videregående layout 

Her skal nævnes de vigtigste layout-værktøjer i Sibelius. 

House Style, som vi også kommer for-
bi i Quick Startdialogen, er betegnel-
sen for en lang række indstillinger af 
teksttyper og layout i øvrigt. Vælg 
fanen Appearance > House Style > 
Import House Style. Her kan vælges 
mellem de indbyggede Styles. Prøv at 
vælge en fra listen og klik OK. Det vil 
resultere i et mere eller mindre dra-
stisk forandret udseende af noden. En 
stor del af de indstillinger som er in-
kluderet i House Style’en kan ændres 
i dialogen Engraving Rules. Vælg 
fanen Appearance House Style > En-
graving Rules (Ctrl + Shift + E / ⌘ + 
Shift + E). I venstre kolonne vælges mellem de mange indstillingsmuligheder. Vælg f.x. 
Rehearsal Marks. Her kan ses de tidligere nævnte variationer af teksttypen. Studér også 
Staves – her indstilles bl.a. hvilken afstand man ønsker dels mellem nodelinjerne, dels 
mellem systemerne.  

8.1. Document setup 

Under Layout-fanen findes endnu en 
lang række værktøjer. Det vigtigste 
er til venstre, dialogen Document 
Setup (Ctrl + D / ⌘ + D). I denne 
dialog indstilles sideformatet (typisk 
A4), orientering (stående/liggende) 
og margener. Her findes også den 
mest afgørende indstilling for layou-
tet, nemlig Staff size. Dette er høj-
den i millimeter på den enkelte no-
delinje, fra den nederste af de fem 
linjer til den øverste. Alt andet på 
nodearket skaleres i forhold til det-
te. Det betyder at en ændring af 
denne indstilling på 0,1 gør en stor 
forskel. Hvis f.x. man har en node der fylder 4 sider, men man kun har en enkelt linje på 
den sidste side, kan man eksperimentere med at formindske nodelinjerne og dermed 
alting på siden en lille smule. Derved kan man få skrumpet noden lige nok til at have 
den på 3 sider. Tjek med oversigtsvinduet til højre i dialogen. Til enkeltstemmer er det 
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almindeligvis ikke en god idé at arbejde med størrelser meget under 6 mm, da det bliver 
for småt at læse for de fleste. Er det derimod et partitur med mange stemmer, vil man 
typisk arbejde med 3 – 4 mm. Staff Margins er også interessant; det er hvor langt inden-
for sidemargenen nodelinjen skal være, bl.a. for at give plads til instrumentnavne.  

8.2. Skjulte instrumentnavne 

Hvis den aktuelle node ser lidt sær ud mht. det, kan det skyldes at selvom vi har brugt 
”Hide Empty Staves”, bliver der stadig gjort plads til navnene på de gemte linjer! Prøv 
evt. at vælge alt (Ctrl + A / ⌘ + A) og dernæst Layout > Show Empty Staves… Så skulle 
du kunne fjerne de navne der alligevel ikke skal vises. Dernæst tilbage til Document 
Setup og regulere Staff Margins, så det ser godt ud. Tjek også gerne om du i øvrigt har 
fået alle detaljer fra forlægget med i din node på skærmen! Alle indstillinger i Engraving 
Rules og Document Setup omfattes af House Style.  

8.3. Egen House Style 

Når man har finpudset disse indstillinger i en node og er tilfreds med dem, kan man lave 
sin egen House Style til at bruge fremover. Vælg House Style > Export House Style og giv 
den et navn. Når man næste gang laver en nyt dokument vil denne nye Style optræde i 
listen, lige til at vælge. Tilsvarende kan man importere den i ældre noder og tilpasse 
deres layout til den ny, smarte stil. Layout-menuen rummer flere værktøjer: under 
Breaks findes linje- og sideskift m.m., Format indeholder forskellige muligheder for kon-
trol over hvordan takter og sider deles op, og nederste del af menuen er kommandoer til 
at nulstille layoutet til de definerede positioner og spatiering. Dette er vældig brugbart, 
da programmet efterhånden er ret modent hvad det angår og af sig selv placerer de fle-
ste ting nydeligt på nodearket.  

9. Rytmepartitur 

Forlæg: Lady Marmalade 

9.1. Instruments/Partitur 

Start en ny node: Vælg File > New (Ctrl + N / ⌘ + N) 
eller klik på øverste venstre knap, det blanke ark. Det 
bringer os ind i New Score-rutinen. Her vælges fra li-
sten manuskript-papiret ”blank”, dvs. endnu uden in-
strumenter. Dem tilføjer vi med knappen ”Change In-
struments”. I ”Instruments”- dialogboksen skal listen se ud som på billedet. Klik igennem 
dialogboksene. Vælg evt. en House Style der hedder noget med ”Inkpen 2” – så ligner 
det forlægget. Indtil man klikker ”Finish” kan man altid gå baglæns og rette i indstillin-
gerne. Når noden er klar (men tom), så husk at gemme! Der er et par ting der skalrettes 
til i forhold til forlægget. Klammerne og instrumentnavnene i venstre side skal rettes til 
– den lille klamme omkring hhv. guitar-linjerne og baslinjerne er en såkaldt ”sub-
bracket”. Klammer findes under fanen Notations > Bracket or Brace. Hvis en sub-bracket 
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ikke umiddelbart er synlig, så prøv at vælge View  Hidden Objects (Ctrl + Alt + H / ⌘ + 
⌥ + H). Taktstregerne skal føres igennem alle linjerne: klik og træk nederst i en takt-
streg i øverste linje – træk ned gennem alle linjerne. (TIP: Find den lille blå firkant) 

Stilartsbetegnelsen og tempoet forekommer muligvis over trommestemmen også. Den 
kan bare markeres og slettes, men den ”korrekte” måde er at vælg Appearance > Sy-
stem Object Positions. I denne liste vælger man hvor såkaldte System Objects skal vises. 
Det er forskellige elementer i noden, som har det tilfælles at de findes i alle stemmer, 
når man skriver dem ud enkeltvis, men i partituret kan man nøjes med at have dem i 
øverste system – eller hvor man via denne liste vælger at have dem (max 5 steder). Det 
gælder såkaldt ”System Text”, volter o.l.  

Når disse ting er klaret skal vi have indsat noderne i partituret. Der er frit valg mht. in-
putmetode (mus, taster, MIDI-keyboard eller Flexi-Time), men vent lidt med tabulatur-
linjerne og trommerne; indsæt altså noder i guitar, piano og bas. Accenterne og stacca-
toprikker i guitar og bas findes på de øverste taster af keypad’et. Marcatotegnet (hat)  
skal man finde på keypad’ets 4. faneblad (F10). Iøvrigt: Når artikulationstegn skal tilfø-
jes alle toner i samme takt kan man vælge hele takten og indsætte den på alle toner 
samlet.  

9.2. Ganske kort om tabulatur 

Tabulatur-linjerne vil vi i denne omgang udfylde ved simpelthen at kopiere noderne ned 
fra de andre linjer. Når noderne er klar inkl. accenter 

1. Markér guitarensystemet (dobbelt/trippelklik),  
2. Alt-klik (kopiér) helt til venstre i guitar-tabulatur-systemet. 
3. Gør tilsvarende med basstemmen.  

Afhængig af programmets indstillinger kan der her forekomme nogle måske knap så hen-
sigtsmæssige forslag til fingersætning. Man flytter en fingersætning fra streng til streng, 
f.x. løs G til 5. bånd på D-strengen, ved at markere tallet og taste Ctrl + pil op/ned / ⌘ 
+ pil op/ned. Har man markeret flere toner på en gang, er det bare piletaster. 

9.3. Trommenotation 

Når man indsætter noder i en trommestemme i Sibelius vha. MIDI-keyboard opfattes de 
indspillede tonehøjder (for det meste!) som var det i G-nøglen. Her skal du starte med 
at indsætte hi-hatten; den skal have halsene opad og derfor være i Voice 1. Den skal 
altså spilles ind på G halvanden oktav over nøglehuls-C. Hvis noderne ikke af sig selv får 
kryds-hoveder, må man udfylde takten, markere den og gå til fanen Notations > Note-
heads og vælge det rigtige hoved (nr. 1 (cross), også Shift + Alt + 1 / Shift + ⌥ + 1 på 
hovedtastaturet). Kopier takten med hi-hat til næste takt (vælg f.x. Note Input > Note 
Input > Repeat (R)). For at indsætte Voice 2 i almindelig node-for-node-input (også kal-
det Step-Time), markerer man første node i hi-hatten og vælger Note Input > Input No-
tes (N). Så kommer indsætningsmarkøren frem igen. Dernæst vælges Note Input > Voices 
> Voice > 2 (Alt + 2 på hoved-tastaturet), eller klik på Voice 2-knappen nederst i keypad-
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vinduet: indsætningsmarkøren bliver grøn. Indsæt stor- og lilletromme med tonerne F og 
C. Tegnene for åben/lukket hi-hat findes på keypad-layout nr. 4 (F10). Sidste punkt er 
at slette overskydende takter og indsætte gentagelsestegn. Vælg  Notation > Common > 
Barline > Start Repeat hhv. End Repeat. 

10. Om MIDI-filer 

 

MIDI-filer er musik der er programmeret på en MIDI-sequenser. Filerne indeholder alle 
data omkring lyd, volume, panorering, rumklang samt naturligvis toner og rytmer i MIDI-
sprog. MIDI-filer kan afspilles i eksempelvis Windows media player eller lignende soft-
wareafspillere (winamp, I-tunes), og benytter de lyde der ligger på computerens lydkort. 
MIDI-filer kan også importeres til Sibelius og danne grundlag for en node enten ved at 
man redigerer indholdet så det giver nodemæssig mening eller ved at man bruger dele 
af figurerne som backing til sin indspilning af melodistemmer eller blæser-, kor- eller 
strygerstemmer f.x. 

Der findes rigtig mange MIDI-filer på nettet, som man kvit og frit kan downloade. Prøv 
f.x. dette link http://www.midisite.co.uk/ eller søg på google med søgeordet MIDI files. 
På de fleste sites kan man søge på bestemte titler. Prøv at søge på en sang du kender og 
måske kunne tænke dig at lave et arrangement af.  

Når du har fundet frem til den ønskede MIDI-fil skal du i de fleste tilfælde højreklikke og 
vælge ”gem destination som” for at gemme. Læg den i din IT-mappe. Start Sibelius og 
klik files/open. Find frem til filen. Når den åbnes kommer der en menu frem som ligner 
den du kender fra ”flexi-timeoptions”, hvor du kan indstille forskellige parametre, som 
kan gøre filen mere læsevenlig. Klik OK og Sibelius vil konvertere MIDI-filen til noder. 
Sædvanligvis vil billedet være ret så uoverskueligt, men du kan evt. bruge ”focus on sta-
ves” til at få overblik over hvad der er hvad. Da MIDI-filer spiller i ”realtime” vil de også 
fylde adskillige sider. Hvis man nu ønsker at fremstille en brugbar node af sin MIDI-fil er 
teknikken at kopiere og indsætte nodematerialet i en ny node – f.x. et leadsheet, et 
rytmepartitur el. en kombination. 

Tip: da der forestår en del redigeringsarbejde for at få nodebilledet gjort læsevenligt er 
det vigtigt kun at hente identiske dele én gang – derefter redigere og kopiere de redige-
rede elementer rundt i den nye node for derved at undgå at gøre det trivielle flere gan-
ge. 

 

Tak til Ole Visby for delvis genanvendelse af materialet. 

December 2014 

Bjørn Petersen.      
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